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This software is Copyrigh©2002 by The Regents of the University of California. All Rights Reserved.

Permission to use, copy, modify, and distribute this software and its documentation for educational, research and non-
profit purposes, without fee, and without a written agreement is hereby granted, provided that the above copyright
notice, this paragraph and the following three paragraphs appear in all copies.

Permission for commercial use or to incorporate this software into commercial products may be obtained by contact-
ing the Technology Transfer Office, 9500 Gilman Drive, 411 University Center, University of California, La Jolla, CA
92093-0093, (858) 534-5815, invent@ucsd.edu .

This software program and documentation are copyrighted by The Regents of the University of California. The soft-
ware program and documentation are supplied “as is”, without any accompanying services from The Regents. The
Regents does not warrant that the operation of the program will be uninterrupted or error-free. The end-user under-
stands that the program was developed for research purposes and is advised not to rely exclusively on the program for
any reason.

INNO EVENT SHALL THE UNIVERSITY OF CALIFORNIA BE LIABLE TO ANY PARTY FOR DIRECT, INDI-
RECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, INCLUDING LOST PROFITS, ARISING
OUT OF THE USE OF THIS SOFTWARE AND ITS DOCUMENTATION, EVEN IF THE UNIVERSITY OF CALI-
FORNIA HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. THE UNIVERSITY OF CALIFOR-
NIA SPECIFICALLY DISCLAIMS ANY WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. THE SOFTWARE
PROVIDED HEREUNDER IS ON AN “AS IS” BASIS, AND THE UNIVERSITY OF CALIFORNIA HAS NO
OBLIGATIONS TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, ENHANCEMENTS, OR MODIFICA-
TIONS.

This software was developed with government support under Office of Naval Research Award
Number: N000140110403. The government has certain rights in this software.

Development of this software was also supported under a grant from the G. Unger Vetlesen Foun-
dation.
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1 General Overview

Analog seismic data have been recorded on numerous pen and paper drum-type seismographs
throughout the world over the past 100 years or so. Digitizing scanned images of resulting seismo-
grams using the available version of digitizing softwad&$can V. 8.0was extremely problematic
becaus@&xScarwas written for Sun Microsystem workstations during the 1980’s and uses the ob-
solete, unsupported “pixrect” primitive graphics library written for the 1980’s Sun architecture and
operating system. AdditionalliyxScanwvas not designed for the efficient digitization of day-long
seismograms for climatological studies (eBromirski et al.[1]). After considerable effort was

spent attempting to improve and stabiliX&Scan incompatibilities of pixrect with current Sun
architectures continued to cause repeated crashes, making the efficient digitization of month-long
time series impossible. ThuSgisDigwas developed using Matlab, which mal&sisDigessen-

tially computer and operating system independent. The hope iS¢sDigcan be relatively easily
maintained as Matlab and computer systems evolve.

Examples and illustrations in this manual were made from Galitzin seismograms from the Berkeley
Seismological Laboratory (BSL) archives that were electronically “scanned” at 400 dpi (dots/inch)
using an IDEAL FSS8000 full length scanner and stored as “tif” files. Each scanned seismogram
image consists of a series of quasi-parallel sequential 30-minute or 60-minute traces that generally
cover about a day, with two partial traces at the beginning and end of each image. One-minute
timing marks usually cause small gaps at the end of each minute. In addition to high amplitude
earthquake signals, the arrival of high amplitude storm waves at nearby shorBlioesréki and
Duennebiel2]) causes elevated noise levels called “microseisms”, both types of signals resulting
in the occurrence of adjacent trace intersections, overlaps, and reduced line thickness that compli-
cate digitization.

Storage problems over time have damaged some seismograms (particularly at edges), further com-
plicating digitization of full seismograms. Degradation of the seismogram paper quality (especially
for many pre-1950 seismograms), and the difficulty in perfectly aligning the 40 inch long seismo-
grams in the scanner feed groove, commonly result in either slightly skewed or slightly curved
trace images, typically exaggerated at the trace ends. These scanning artifacts become apparent if
the horizontal:vertical image ratio is augmented, but are difficult to identify in the raw tif images.
The effects of these scanning artifacts were minimized by fitting a third order polynomial to the
image traces to establish a reference line for each trace to determine the digitized trace amplitudes.

Because of presumably varying voltage, Galitzin seismograph drum speed variability resulted in
the Time Scale Factor (TSF) varying from about 450 to 480 pixels/min. Impact of the variable
TSF is minimized by using an average pixels/min determined for the entire seismogram. When
digitizing relatively short duration earthquake signals, estimates of the TSF should be made either
just prior to the event or from an average of the TSF for traces before and after the event.
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2 Main Features

SeisDigs a Graphical User Interface (GUI) based interactive digitizing tool. Digitizing operations
are mouse selected. Because digitizing numerous entire seismogram images efficiently is critical
for studying the characteristics of extreme storms and their occurrence for climate change analy-
ses, automated trace image tracking is necessary. Efficient digitizing necessitates a minimum of
user interaction.

SalsDg — Shome stchuang) project/1 940 fdec/ prep—nofilt—brk_40_12_1 7—prap uf
Rie rege Edi

Detay [ | A0 "\

- =S

e et

hl.bﬂl-#pmjn'b'ﬂlﬂlhﬂ:l I LINES| sx =] 1 ] '_"i:I:
- iy O Mk W12 15w = g e | F2P: ||
. “"?‘i 0] H.I—h
-3 ey [ b 13 1 Tiwws {uin] Sow (i) |

T e S T |

|

|

A = i - . .
| P | o Srivvied || MAAR G2 pre

Figure 1. A portion of the seismogram for Dec. 17, 1940 viewed \B#sDigshows the trace
variation observed in pre-1962 Galitzin seismograms, with an example of faded trace lines at the
seismogram edge that sometimes occurs in older seismograms. The scanned traces (thick white
lines) show examples of adjacent trace intersections during relatively high amplitude noise levels.
The projected digitized traces (blue lines) successfully track past these irregularities. The magenta
trace is the current (active) trace under inspection. Etige Line(vertical green line) is shown

on the left, its position adjusted to conserve the total elapsed time of the seismogram. The full
seismogram image is shown in the locator panel at the lower right, with the portion of the image
shown in the main image panel outlined by the red box and the active trace identified by the dashed
magenta line. The right Edge Line is set at the well defined trace ends. The paper seismogram
physical trace length in inches (determined usingAhg. SCALE FACTOR value displayed, i.e

the DPI) is shown at the top of both the m&risDigand the locator panels.
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Timing marks, occuring at 1-minute intervals in most Galitzin seismograms, cause small gaps in
the seismogram image, and high amplitude signals result in trace intersections and overlaps (see
Fig. 1). The trace width can vary within a trace as well as from trace to trace. Each of these, as well
as other gaps and thin or intermittent lines, can cause incorrect trace-tracking. The necessity of
setting control points at gaps and intersections was substantially eliminated with a trace-tracking
algorithm that follows the center of the trace image (in the vertical cross-section) and uses a com-
bination of slope estimates from both the preceding digitized points and the trace amplitude range
to constrain the forward digitizing search. Trace tracking is further constrained to recross the base-
line within a user selected time period. Incorrect handling of trace intersections and other image
irregularities (commonly occurring when high amplitude signals cause repeated trace intersections
or overlaps) are easily identified by visual inspection of the projected digitized trace overlaying
the raw image trace. The GUI allows interactive modification of the digitized trace(s) (as well as
setting control points at trace ends for pre-processing) prior to saving to an output file for cases
when image quality and/or complexity warrant user interaction.

SeisDigoperates on black-and-white images, 0-and-1 pixel values, respectively. Grayscale or color
images are automatically converted into black-and-white.

2.1 Installation and Matlab/System Requirements

A “tar” file containing the MatlalSeisDigm-files and sample image files can be downloaded from
http : //ccs.ucsd.edu/~ peter/ and should be untared in the usergmatlab directory, creating

a SeisDigdirectory with a data subdirectory containing sample image files, and should be added
to the user's MATLABPATH. Minimum system requirements: Matlab V.6.0 or higher with Image
Processing and Signal Processing Toolboxes, and 256 Mb memory; Matlab v.6.1+ with 512+ Mb
memory recommended.

2.2 Image File Formats

Acceptable input image file formats are those that Matlab function “imread” supports. These in-
clude TIF, JPEG, GIF, BMP, PNG, HDF, PCX, XWD, ICO, CUR. Images of these types can be
imported directly without requiring conversion or modification.

2.3 Required User Inputs

If the image does not contain timing marks or only a section of a trace is to be digitized, the user
is required to enter the time in minutes (1) between the Edge Lines (generally between identifiable
minute marks), which is needed to determine the Time Scale Factor. The “dots per inch” (DPI)
image scan rate (2) determines amplitude scaling (the default is 400 dpi). If the DPI is unknown,
the physical length of the horizontal dimension (independent variable) of the scanned image must
be entered. In th&xport (Preview)window (see Sectio3.1.3 Fig. 5), the user is required to
enter (3) the absolute Start Time of the seismogram or the section of the image to be digitized,
and (4) the desired digital output sampling rate, i.e. 1/Delta. When digitizing entire seismogram
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images, the absolute End Time (5) may also be needed to ensure that the independent variable
(time) is correctly conserved during trace concatenation. Additional header information prior to
output, such as station name and channel identifier, are optional but can also be entered in the
Exportwindow.

2.4 Pre-Processing

Much of the time required for digitizing an entire seismogram image (depending on the degree of
user interaction needed) is CPU and memory intensive, with digitizing a 30 min trace requiring
about 1.5min or more. For efficient digitizing of day-long seismogram images, it is useful to de-
termine the projected digitized traces for the entire seismogram prior to inspection, modification,
and saving. After loading the image file, control points must be selected at both ends of all traces
to be digitized while innsertmode. These points should be near the trace ends, but need not be
exactly at the end of the trace image. For efficient control point selection along one side of the
seismogram, activating tiene #check box allows automatic incrementation of the line number
when adding successive line-end control points. Control points can be set at trace ends along one
side of the seismogram either with individual mouse clicks at each trace end, or setting a series of
end control points by holding down the left mouse button on the non-image region (black) above
the initial trace end of the series and dragging the cursor to the non-image region below the last
trace in the series (i.e. black-to-black). Line #'s for groups of multiply-selected control points are
automatically incremented from top-to-bottom, and decremented when dragging the cursor from
bottom-to-top (this makes setting control points at trace ends more efficient). Groups of incorrectly
labeled trace-end control-point line numbers can be selected by togglifgeteet Pointdutton

and holding down the right mouse and dragging the cursor. Selected groups of control points can
be decremented or incremented using-the or ++ buttons, respectively.

fhome Sstchoangproject/1940 /dec /Al

prep-rot-90 miry filt bk 40 12 15.dat: |
prep-rot-20 mivy filt ek 40 12 16.4dat:
rep-rot-90 wiry filt helc 40 12 17 .dat

prep-rot-90 mivy filt hrk 40 12 18.dat [
prep-rot-20 mivy filt ek 40 12 19.4dat:

- |
Add | Remove | Digitize Files |

Figure 2: The pre-processing file list showing typical filenames produceaddpyimages.mThe
highlighted preped image file was digitized, with the output displayed in Fig. 1.

The default intermediate processing filenames have the same basename as the image file, although
the user can enter any filename. Projected trace data and/or associated control point and Edge Line
data are saved in a file having a “.data” extension (unless the user enters a different filename) by
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clicking on the ‘Save Databutton. This flename automatically appears in tieeprocess File

List”, located in the lower left corner of Fig. 1. The *.data files are actually *.mat Matlab “save”
files. The directory path that these files are stored in is shown aboverépeocess File List
Double-clicking on filenames in this list, either image *.tif or *.data files, will load that file. Files

to be digitized can be added or removed fromRmneprocess File LisfFig. 2) using the Add” or
“Removébuttons, respectively, with the files to be processed highlighted after being selected from
the list by mouse click. Preprocess files not in the current directory can be added to the list using
their complete pathnames. The CPU intensive operations can then be performed at a convenient
time by clicking on the Digitize Selected button, with computed projected traces stored in a
*.data file that has “tr-” prepended to the filenamé&oad Datd loads the selected trace tr*.data
object file for inspection and correction, with the user prompted to load the associated image file
for comparison with the projected traces if it is not already loaded. Inspection of the projected
digitized traces can be done conveniently using&bt Scrollfunction.

2.4.1 Preparing Images for Digitizing

Removing stray pixel “noise” from images af@F rotations are time consuming operations. When
digitizing multiple seismograms that require the same operations to prepare the image for trace
end control point selection and digitizing, it may be more convenient to do filtering and rota-
tion operations using therep.images.nfunction that can be run independentlyS#isDig(“help
prep.images in Matlab gives usage). This function performs the same operations as lim#ge

menu withinSeisDig creating a new tif file (with the filename prepended with “prep-" and abbre-
viations of all operations performed, see Fig. 2). Preped tif files can be loaded later to set control
points at trace ends, with control point and image data automatically stored in a new file having
the same basename as the preped tif file but with a “.data” appendage, with the new filename
automatically added to thereprocess File Listor digitizing.

2.5 Edge Lines

Edge lines are used to delineate the horizontal (independent variable, time) trace extent. Edge lines
need to be set prior tBxport Edge line locations can be adjusted by positioning the cursor over
the Edge Line, holding down the left mouse button, and dragging the Edge Line to the desired
location. Incorrect scanning can cause the trace ends of seismograms to not be aligned directly
beneath each other, i.e. non-vertical, which can be identified by increasing the horizontal:vertical
Image Ratio To account for the slight slope of the trace ends and conserve the total elapsed time
in the seismogram, the Edge Lines may be rotated by positioning the cursor over the upper end of
the Edge Line, holding down the left mouse button and dragging the cursor to either side.

When digitizing full seismograms, Edge Line locations are selected by picking a balance between
the quality of the image trace ends and the trace length of the paper seismogram (keeping in mind
that there is a slight slope to the spiraling traces, resulting in the trace length being slightly longer
than the seismograph drum circumference). If the trace length is measured, adjust the Edge Lines
until the value in the Scale Factofgnp. Lengttdialog box matches the measured length. If the
image quality is poor at one end (as in Fig. 1), set the Edge Line at the good end and iteratively
adjust the other Edge Line to the measured trace length and/or until the Total (elapsed) Time in the



SeisDig User’s Manual 10

seismogram (determined in thport (Previewwindow, see Fig. 5in Sectiddi 1.3 is adequately
conserved.

_| LINE#| <<| <| 38 =] -+4

Digitize:  Line | Pt2Pt |

Max Pexiod: 700  Smooth Da:tal

Figure 3: Line activation and digitizing controls.

2.6 Trace Activation (Line Numbers)

When multiple traces are being digitized, the current (active) line number is displayed in the
“Line #” dialog box (Fig. 3) below the mai&eisDigimage panel (Fig. 1), with the current trace
under inspection identified with a magenta line (other projected digitized traces have blue lines).
The location of the active trace is also identified by a magenta line in the locator panel. Line
numbers are also displayed to the left of the main image panel. Line numbers are useful when
editing connection sections between successive concatenated traces. A line is “activated” or made
“current” (i.e. selected for control point changes and/or digitizing) by entering the desired line
number in theline #dialog box and striking “Enter” on the keyboard, using the associated for-
ward > and backward< arrows for scrolling, or by clicking on the desired line number to the left

of the main image panel. The< button makes the lowest numbered trace the active trace. For
efficiency when sequentially setting pre-processing control points for successive trace end points
at one side of the seismogram image, the line number is automatically incrementediiehe

check box is activated. If left and right side line numbers are inadvertently misaligned (indicated
by the yellow baselines having substantial slopes because the endpoints are incorrectly selected on
adjacent traces), resequencing can be accomplished by selecting groups of control points on one
side of the seismogram (by holding down the right mouse button and dragging the cursor while in
Select Pointsnode) and clicking on either backward- or forward-++ buttons.

2.7 Trace Digitizing and Filtering

Individual trace digitizing is accomplished by clicking ohifie” (Fig. 3) to digitize the entire

trace, or Pt 2 Pt to digitize the portion of the trace between selected points. Oihe and Pt

2 Ptbuttons (red with blue background) operate on the current active line indicatedlimthé

dialog box. ThePt 2 Ptfunction is used during projected trace modification prior to export. The

Pt 2 Ptend points, Beginning and End, are selected with left mouse clicks after clicking on the
Pt 2 Ptbutton. To facilitate the selection of the End pointRh 2 Pt mode, right mouse clicks

shift the image only horizontally. Note that floating baselines are used because of potential trace
curvature. The baseline location is determined from a linear least squares fit to all control points in



SeisDig User’s Manual 11

a line, and the trace-tracking alogorithm operates relative to this baseline. Consequently, to avoid
the possibility of changing acceptable previously digitized portions of a trac&ttBePt opera-

tion should generally be used when modifying previously digitized data after inserting additional
control points within the poorly tracked segment. The maximum time in seconds allowed between
recrossings of the reference baseline is givenMgX. Period’, and is particularly useful for high
amplitude data with multiple overlaps.

The image line-thickness variability along the trace causes small jumps in the projected digitized
trace unrelated to the frequency content of the underlying signal. Consequently, a three-point tri-
angular filter is automatically applied to the digitized output. If inspection of the digitized trace
warrants further filtering, additional triangular filtering of the current (active) projected digitized
trace can be applied by clicking on th8rhooth button, with each mouse click successively ap-
plying a three-point triangular filter to the current projected digitized trace, which can be undone
if the result is unsatisfactory. Note that this is a lowpass filter that will cause a loss of energy at
higher frequencies.
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3 Menus

All operations necessary to digitize an entire seismogram image can be performed within the GUI,
including image filtering (for “noise” reduction), image rotation and inversion, and output trace
inspection and modification.

There are three main menus at the top left corner of the GUI (see Figild,)image andEdit.
3.1 File Menu
Operations under theFile” menu deal with loading and saving image and data files.

Load Image..
Load Data...

save Image...

Save Data. .

Export (Preview)...

Close

Figure 4: Operations performed under ik menu.

3.1.1 Importing Images and Processing Data

Images are imported (loaded) by clicking on thHélé” button at the top left hand corner and
selecting Load Imagé, and then selecting the desired image file from the directory dialog box
that pops up. Similarly, files containing control points and pre-processed projected trace estimates
can be loaded by selecting.dad Datd. The filename of the loaded image being displayed is
shown at the top of th&eisDigwindow.

3.1.2 Saving Images and Processing Data

Similar to importing images, modified images and processing data (including control points and
Edge Line locations) can be saved for further editing by clicking on 8evé Imageand “Save

Data” buttons, respectively. All user entered data, including control points, Edge Line locations,
and projected digitized trace estimates are stored in the tr*.data files 8aderDataChanges to

a raw image (either orientation or filtering) can be stored by clicking on$a&é Imagebutton.

3.1.3 Exporting Digitized Data

Digitized data are saved to disk by clicking oBxport (Preview). An Exportwindow (Fig. 5)
pops up in which the user must enter the Start Time and the sampling rate (1/Delta) of the digitized
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Time {minutes)
973 974 973 976 977 978 979 980 961 552

Start, |12!1 71940 8:28 AM | Samplesfsec: 1 # Sec Displayed: | GO0 <Prev | _| Line | Mext= |
End Time |1 215/1340, 8:36:00 AM Station BREK Event Hame: max 16 chars Save as SACI
Month Julian day  Year Comp. Name: LHZ Event Origin:|| -12345 Save as MAT |
352 1940 Min: -6.16 Arst Amvivall| -12345 Save as Both|

hour : min : sec : ms Mean -3.16e-05 Event End:l -12345
8 :z6 /o : oo Max: 6.22 Total Time (sec): 86880 Cancel |

Figure 5: Layout of the Export (Preview) pop-up window. The top panel shows the concatenated
output of the digitized data for the full seismogram shown in Fig. 1, containing 48 traces of approx-
imately 30 min duration each. The portion of the digitized trace outlined by the red locator box
(600 5s) in the upper panel is expanded in the main panel for detailed inspection. The yellow dots
indicate the sampled amplitudes to be exported. Note the semi-regular coda-like arrivals, indicative
of microseisms generated by the arrival of ocean swell at nearby shorelines.

trace data, and any Seismic Analysis Code (SAC) header information availabl8ec. Dis-
played’ gives the length of the time segment displayed in the main panel in seconds. The location
of the expanded trace section shown in the main panel can be selected by either clicking on the
trace in the top panel, dragging the slide bar at the bottom of the main panel, or clicking on the
“<PreV or “Next>" buttons (when the associated checkbox is séfih@) to inspect connections
between consecutive concatenated traces, with the connection points indicated by vertical green
lines in the main panel (see Fig. 5). Toggling thiae checkbox in theExportwindow switches

to Nmax which allows jumping to successive trace maxima (useful for locating spikes that are
generally associated with improperly digitized segments).

Header information for SAC output requires entry of the sampling rate (1/Delta, samples/s) and the
Start Time of the data, which includes date information. The Start Time corresponds to the stan-
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dard SAC header “Reference Time”, but differsSaisDigwhere it must be the beginning time of

the data being digitized. The inverse of the sampling rate, i.e. the sampling interval Delta, is output
in the SAC headers. The locations of samples taken for a given sampling rate are determined by the
number of pixels/s, which is obtained from the measured pixels/min from the seismogram image.
The 400 dpi Galitzin images have about 7.7 pixels/s. Uik&canwhich truncated the pixels/s
estimate causing slightly shifted spectral estimasessDiguses spline interpolation to determine

the trace amplitudes at the locations specified by the sample rate entered.

To check the conservation of total elapsed time when digitizing full seismograms, the End Time
needs to be entered. A pop-up window gives the Digitized Total Time (determined from the digi-
tizing process) and the Entered Total Time (determined from the Start and End Times entered) in
seconds. Typically, these differ by a few hundred seconds for a full day-long seismogram. The user
has the option of accepting the Entered Total Time (generally recommended), in which case the
sampling interval (i.e. the Time Scale Factor, TSF) will be adjusted accordingly, and/or slightly
shifting one or both of the Edge Lines and then re-Exporting. Note that the TSF is an average
estimate from all the individual lines in the seismogram, and thus has an associated variance.

Digitized data are exported by selecting eith&at’e as SAC(the common SAC format) or
“Save as MAT (a Matlab *.mat file that mimics the SAC2000 Matlab output). SAC2000 can

be downloaded frorhttp://www.lInl.gov/sac/The Matlab output *.mat file includes a trace vector
(SeisDaty, and a header “structureSACdata that contains necessary information found in the
SAC2000 Matlab header, includingseisDigstruct containing digitizing parameters (see Section

9). There are often numerous data gaps in the older Galitzin seismograms (see Fig. 1). Thus, in
order to keep the number of data files to a manageable level, the SAC files gener&iid g

differ from standard SAC files in that missing data gaps are designated by “-12345”, and with
NaNs in the Matlab *.mat output files. The output digitized trace amplitudes are in millimeters
and correspond to trace amplitudes of the paper seismogram. The SAC header variable “scale” is
set equal to 1.

The Begin ValueandEnd Valuefields in theSeisDigSAC header are set to the first and last data
points exported. If an earthquake event is embedded within the output daEaeheOrigin First

Arrival, Event Endimes may be seleted by mouse clicking on points in the maaportpanel after
activating the respective button, with middle mouse button clicks causing lateral translation of the
trace image centered at the cursor location. The event times are indicated by vertical magenta lines
in the mainExportpanel. The values for the event times stored in the SAC header are the number
of samples from the beginning of the output trace. These points can be located in absolute time
from the Start Time of the data file and the Delta. Choosing event times is optional, with these
values set to “-12345” in the SAC header if unspecified. Entering -12345 in any of the Event

fields erases the associated magenta line.

3.2 Image Menu

The digitizing algorithm operates from screen left to right. Thus, the independent variable (time)
must be increasing from left to right. Some seismograms need to be scanned lengthwise or inverted
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because of physical damage to the paper during storage. Consequently, several image manipulation
functions (Fig. 6) are included to align the image correctly for digitization. Aging or damage to
the paper seismogram during storage can result in the inclusion of non-seismic “image noise” that
needs to be filtered for efficient and accurate digitization by the trace-tracking algorithm. Most
of these operations are time consuming. When digitizing multiple seismograms having the same
characteristics, it may be more convenient to perform these operations exte8sasDigusing
prep.images.nisee Sectio2.4.7).

Mirror About - Axis |
Mirror About X-Axis

Rotate 180

Rotate +30 (slow)

Rotate -30 (50w

Filter Image Moise (slow)

Erode Image (slow)
Dilate Image (slow)

Inwert Image
Feload From Disk

Figure 6: Operations performed under theagemenu.

3.2.1 Image Manipulation Functions

Seismogram images can be rotated about either the screen x-axis or y-axisNisiog About
X-axis or “Mirror About Y-axi$, respectively. Rotation of the image about the screen z-axis can
be done by clicking on theRotate 180for 180° rotation, or ‘Rotate +90 or “ Rotate -90 buttons

for clockwise and counter-clockwis#)° directions, respectively (the 90° rotations are much
slower operations because of memory reallocation).

3.2.2 Image Filtering

“Filter Image Noiséremoves spurious isolated pixels and offset minute marks that interfere with
accurate automated digitizing, and is recommended for most imagesd€ and “Dilate” func-

tions effectively contract or expand, respectively, the image trace line thickness, but are not rec-
ommended for use except in special cases. Because image filtering operations cannot be reversed,
these features should be used with caution. If the results of any of these functions are unsatisfac-
tory, the image can be reloaded.

3.2.3 Invert Image

This function switches the background/foreground from white-to-black and vice v8esaDig
requires a black background, i.e. pixel values set equal to zero.
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3.2.4 Reloading

In the event that an image is over-filtered or in some way corrupted during digitizing operations, the
current image file can be reloaded using tRefoad From Diskoption, which clears all objects
and control points.

3.3 Edit Menu

Digitizing modifications can be facilitated by being able to add or remove previously determined
overlays, as well as undo incorrect trace modifications. Such functions that have proved useful are
found in the ‘Edit” menu (Fig. 7).

3.3.1 Undo

All operations are stored for possible restoration to the prior state (elhknegemenu operations).
Successive operations can be reversed by clickingmdt’ or striking “<ctrl> u” using the
keyboard, or also by striking” if the main image panel has been activated with a mouse click
(i.e. is the current Matlab object).

Undao L1 <Ztrl=—1

F Show Contral Paints
F Show Trace Data
Show Opposite Image Edge

Show Reference Line
Cirder of Fit -

g irni g g g o Penien
LANRINRING ILTIDIRG D DWRSL Y LAWAIOA

Delete Line Cantral Paints

Find kdinute kdark Locations
Femove kdinute kdark Labels
Plot Pis/rinsTrace

Cebug/Restare

Figure 7: Operations performed under tait menu.

3.3.2 Overlay Display Options

Operations for the entire image include erasing or redisplaying all control points and/or the pro-
jected digitized traces from the viewed image by toggling tBadw Control Pointsand “Show
Trace Datd buttons.
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3.3.3 Show Opposite Image Edge

When digitizing multiple traces, setting control points at trace ends for preprocessing and adjusting
the Edge Line fit, checking trace concatenation and trace numbering, or checking the reference line
fit to the image, Show Opposite Image Edgarovides a convenient function to observe the traces

at opposite ends of the seismogram image simultaneously.

3.3.4 Show Reference Line

The seismogram image traces can be slightly curved due to incorrect paper feed in the scanning
operation. To establish a reference line for determining output digitized trace amplitudes that
accounts for this slight curvature, a polynomial fit to the digitized points of orders 1, 2, or 3 can be
can be chosen using th®tder Fit’ option. It is recommended that full traces be digitized using

a third order polynomial (the default). However, when digitizing shorter trace segments, a linear
reference line may be more appropriat8hbw Reference Liheverlays the selected polynomial

fit on all traces for visual inspection.

3.3.5 Delete Line Trace Data

If the trace-tracking algorithm gets completely “lost”, it is sometimes necessary to redigitize an
entire trace. Delete Line Trace Datadeletes all previously digitized data points only for the
current (active) line.

3.3.6 Delete Line Control Points

“Delete Line Control Pointgdeletes all control points from the current (active) line.

3.3.7 Minute Marks

The locations of minute timing-mark (gaps) are estimated using a modification of the trace-tracking
algorithm, and are numbered sequentially and overlaid on the image usingikdeMinute Mark
Location$ function. Identifying minute marks is used to determine the Time Scale Factor, i.e.
the number of pixels/min (see Sectidnl below), needed to determine output trace sampling
locations. The DPI needs to be entered (or estimated) to determine the minute mark locations. The
overlaid minute mark numbers can be removed for the entire image witiRRéradve Minute Mark
Labels function. TheFind Minute Mark Locationgunction may not work well for images with

trace overlaps. When digitizing full seismogram images, it can be useful to examine the variation
in the pixels/min and minutes/line estimates for all the traces usingRla Pix/Min/Tracé
function.

3.3.8 Debug/Restore

Occasionally, problems with either Matlab or the trace-tracking algorithm can occur. Déze “
bug/Restoréfunction resets the GUI buttons, and restores line labeling and the baseline locations.
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4 GUI Functions

Various functions for moving around the seismogram image and correcting poorly tracked traces
are activated by mouse clicking on the appropriate “button” at the left of the main image panel
(Fig. 1). That function remains active until either reclicking or another button is activated. Because
each of these functions use left mouse clicks, only one of these functions can be active at one time.

4.1 Navigation

Moving within the image can be done by (1) using the scroll bars on the bottom and right hand
sides of the displayed image, (2) by clicking on the desired location in the locator panel at the
lower right, (3) by using theShift Imagé button, or (4) centering the image at the current cursor
location by right clicking. The displayed portion of the image in all cases is identified by a red
box in the locator panel at the lower right, which displays the full image and identifies the current
active trace with a horizontal magental line.

Shift Image|
| Zoom
-|[ 120 4+
Image Ratio
1 |1
b4 ¥

Auto Scroll|

Delay IT

Figure 8: Image navigation controls. TAeombutton is activated, i.e. beige.

4.1.1 Shift Image

Activation of theShift Imagebutton allows “grabbing” and dragging the displayed image by hold-
ing down the left mouse button and moving the cursor.

4.1.2 Image Magnification

Activating the “Zoont button allows image magnification (left button, zoom in) or reduction (right
button, zoom out), with the zoomed image centered at the cursor location. The size and location of
the red location box in the locator panel is adjusted accordingly. Zooming can also be accomplished
by clicking on the “+” or “-” buttons adjacent to the zoom magnification dialog box, with zooming
directed towards the upper left corner of the image. Clicking the middle mouse button centers the
image at the cursor. The degree of zooming for both mouse clicks in the main image panel and
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using the + or - buttons is a pre-determined percentage of the size of the initial red locator box,
i.e. the size of the initial image displayed in the main image panel. The degree of zooming desired
can also be manually entered in theomdialog box, also relative to the initial main image (red
locator box) size.

4.1.3 Image Ratio

Increasing the apparent relative amplitude of the dependent variable (i.e. the vertical or y-direction
with an x:y Image Ratioof 1:50) is useful for identifying irregularities resulting from improper
scanning, i.e. excessive trace curvature (the trace images should be nearly linear). Conversely, to
check alignment of the trace ends, a horizontal:vertroalye Ratiaf 100:1 facilitates the accurate
selection of Edge Line location and slope.

4.1.4 Auto Scroll

After pre-process digitization of a full seismogram, cursory inspection of of the projected digitized
data to identify incorrectly traced segments can be performed ugiatp “Scroll’, which steps
through the entire seismogram in increments the size of the red box in the locator panel, with the
viewing time in seconds between successive portions entered iDlay’ dialog box. Either
mouse clicking orAuto Scrollor anywhere in th&eisDigwindow stops scrolling.

4.2 Digitizing Control/Trace Editing Functions

Digitizing trace images requires choosing control points to constrain the digitizing algorithm, and
to correct poorly tracked trace segments. Only one “trace editing” button can be activated at a time,
with the activated button becoming green (see Fig. 9). Trace editing functions apply only to the
line number displayed in thieine #dialog box, the active trace, unless tt@utrent” checkbox is
toggled to ‘All Lines’. The Current / All Linescheckbox applies to all trace editing functions.

4.2.1 Control Points

Control points are needed at the beginning and end of each trace to identify the time-axis (indepen-
dent variable) baseline and the trace extent, and within traces when the trace-tracking algorithm
has difficulty correctly following a trace. Control points need not be set at the exact end of the trace
(the trace-tracking algorithm will go to the end regardless). Control points can be added at multi-
ple trace ends by holding down the left mouse button and dragging the cursor from black-to-black
(non-image) locations, with a control point inserted at each crossing of a trace image (white re-
gion). Control points can be added only to the current active line indicated Lnriketdialog box
(unless theLine #check box is activated for adding control points at multiple trace ends for pre-
processing). Control points associated with the number irLihe # dialog box (active) are red,

while inactive are blue. Activating therfsrt Ctrl Pt” button allows adding as many control points

as needed at selected cursor locations with left mouse clicks. Control points generally should be
vertically centered in the image trace (the default setting). Centering can be turned off for special
cases by toggling theCentet check box (changes taExact”), and is particularly useful turned
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M Center

Del CtH Pt
select Pts
Erase Trace]
M Cwrent

Figure 9: Trace editing controls. The trace editing buttant Ctrl Ptsis activated, i.e. green, with
the Centercheckbox activated causing subsequent control points inserted to be vertically centered
in the Currenttrace indicated in theine #dialog box.

off when adjusting the tracking at trace intersections.

Incorrectly added control points can be deleted at any time by activating@deCtrl Pt” button

and then clicking on the erroneous control points with the mouse. Individual control points can
be deleted from any trace at any time with mouse clicks by togglingimeent checkbox (the
default) toAll Lines Successively added control points can be sequentially deleted by striking the
“u” key for “Undo” after activating the main image panel is made the active object by mouse click.
All control points in a trace may be deleted wibielete Line Control Points the Edit menu.

4.2.2 Select Points

Groups of control points can be selected for deletion or for incrementing line numbers by activating
the “Select Pointsbutton and then holding down the left mouse button and dragging the cursor
to encompass control points on t@eairrentline or on multiple lines when thall Lines button

is active. To delete selected groups of control points, select the control points and then strike the
keyboard “Delete” key. To increment or decrement, select and then click erthes —— buttons,
respectively.

4.2.3 Erase Trace

High amplitude signals result in trace overlaps that generally require interactive modification of the
projected digitized trace. Incorrectly tracked trace data can be removed usingrése ‘Tracé
function, holding down the left mouse button and dragging the cursor to delineate projected trace
data to be erased. Tli@urrent / All Linescheck box applies t&rase Trace(as for other trace
editing functions) so that incorrectly tracked signals can be erased without affecting previously
correctly digitized adjacent traces. An entire digitized trace may be delete®eidite Line Trace
Datain the Edit menu.
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5 Time and Amplitude Scale Factors

Scale factors for both the independent variable (Time for seismograms) and the dependent variable
(Amplitude) (see Figures 1 and 10) need to be either entered or computed prior to exporting
digitized data.

SCALE FACTORS
Time {min) Amp {in.)
Length: 30 807 35,583
pizfunit: 452 400

Figure 10: Time (independent) and Amp (amplitude, dependent) variable Scale Factors, showing
values typical for earlier Galitzin seismograms (see Fig. 1).

5.1 Time (Independent Variable) Scale Factor

The digitizing Time Scale Factor (TSF) is needed to determine the sampling “locations” along a
projected trace to obtain the digitized output. An accurate estimate of the TSF (pixels/unit(min))
of the image is also needed to ensure conservation of elapsed time between Start and End Times
of the seismogram. The seismograph drum spin rate varies over time (even hourly) for older Gal-
itzin seismograms, giving variable trace lengths (i.e. number of minutes/trace). Thus, the TSF
should be estimated for each seismogram. The TSF is determined automatically when digitizing
full seismograms (that have minute mark gaps) as the mean of the pixels/min estimates (excluding
outliers) for all lines to be digitized. The variation in the (pixels/min)/trace can be examined using
the Plot Pix/Min/ Tracefunction in theEdit menu, and which loads the automatically-generated
associated “gaps-” file.

When digitizing short segments of seismograms, the TSF can be estimated by entekieggtie
(number of “units”) between two selected points within a trace (generally minute marks) delin-
eated with the Edge Lines (i.e., for seismograms, the number of minutes) in the Scale Factors
“Time (min) dialog box. The number of minutes can be determined usingfred“Minute Mark
Locations function in theEdit menu, with the minute mark gaps numbered sequentially between
control points and shown on the trace to check that the minute marks were correctly identified.
These numbers can be removed ugR@move Minute Mark Labeis the Edit menu.

When tick (minute) mark gaps are absent (as in Fig. 1), the image quality is poor, or multiple trace
overlaps occur, the minute marks may not be identified correctly with eith&itldeMinute Mark
Locationsfunction or by visual inspection. In such cases, the TSF (pixels/min) must be entered
manually. This is done by activating thene, pix/unidialog box by mouse click and entering the
pixels/min value (or using the default estimate of 470), and striking the Enter key. The computed
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trace length (in minutes) based on the entered TSF (and the Edge Line positions) will then appear
in the Lengthdialog box.

The TSF can also be determined for the full seismogram using the the Start and End Times (an-
notated on the physical seismogram) entered inBkgort (Preview)window. If Start and End

Times are entered and accepted, the computed TSF will not be used. Because the trace length
in older Galitzin seismograms can vary from slightly less than 30 min to about 31 mifPlgie
Pix/Min/Tracefunction in theEdit menu also plots the number of minutes per line), the TSF es-
timate should be obtained from the displayed seismogram image or from a trace chronologically
close.

5.2 Trace Amplitude (Dependent Variable) Scale Factor

The Amplitude Scale Factor (ASF, dependent variable) for the digitized time series corrsponds to
the image DPI (dots per inch). The DPI is used to convert the seismic digitized trace output ampli-
tudes from pixels to millimeters. The DPI is generally known and should be entered in the Scale
Factors Amg pix/unitdialog box (the default is 400 dpi).

If the DPI is unknown, the original paper seismogram physical size, i.e. the measured trace length,
can also be used to determine the number of pixels/inch or DPI amplitude scaling of the image.
The units of the paper seismogram physical trace length that generated the scanned image are in
“inches” to conform to the DPI convention. Enter the paper seismogram trace length_ienttyidn

Scale Factor&émpdialog box (see Fig. 10). The number of pixels between the Edge Lines set at
the trace ends then gives the ASF.
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6 Digitizing Quality Control

The projected output trace of the digitizing algorithm should be inspected to ensure the quality
of the digitized data. Because there are several factors that affect the trace image quality, initial
projected digitized trace estimates often require correction. AfterProcessingentire images

can be scanned for digitizing errors usiAgto Scroll Prior to saving to disc duringxport the
concatenated digitized traces are displayed in a scrollable window that appears after clicking on
Export (Preview)n the File menu. After correction, the digitized data must beesgrorted and
modified sections should be re-inspected.

6.1 Interactive Trace Modification/Editing

Incorrect image trace-tracking is easily identified by comparing the projected digitized trace with
the underlying image, or by identifying inconsistent amplitudes inBkgort (Preview)wvindow.

Poor trace tracking generally results in high amplitude “spikes”, which can be located by searching
through the trace in the makxportpanel using the scroll bar or by toggling thime checkbox to
Nmax(the “next maximum”) and examining successive maxima. Poorly tracked sections should
be modified in the mai®eisDigpanel and then r&xported

Changing the trace-tracking can be accomplished by inserting control points at locations where the
projected digitized trace deviates from the underlying image. Clickinghsrt Ctrl Pt activates
Insertmode. In most cases, re-digitizing modified trace sections should be done uskPigPtire
function. This reduces digitizing time and avoids the possibility of adversely affecting previously
digitized trace segments that were acceptable.

Control points should then be inserted to guide the tracking along the correct path. Groups of con-
trol points can be inserted in poorly tracked segments along a single trace (whkemmode

with theCurrentcheckbox active) by holding down the right mouse button and dragging the cursor
horizontally from a non-image region to another non-image region (black-to-black) along a trace,
with control points set at each image location (white) crossed.PEt2Ptdigitizing function can

then be applied. On occasions when the image quality is poor but the trace is potentially identifi-
able, it is useful to load the raw, unfiltered seismogram image, overlay the projected digitized data,
(determined from the filtered image) and use the raw image data as the guide for setting control
points to improve trace tracking. Although generally unnecessary, sections of a digitized trace that
have been poorly tracked can be deleted wiErese Trac&by holding down the left mouse button

and selecting the desired area. Several applications #fttA€tdigitizing function (with repeated
additions of control points) should be used prior to resortin§gbne Fitting

6.1.1 Spline Fitting

In instances of extended poor image quality but with a visually identifiable trace, holding down the
left mouse button and dragging the cursor from an identified portion of the trace image to another
identified image point (“white-to-white” while ilnsertmode) identifies a section for “spline” fit-

ting. Other pre-existing control points within the splined section become incorporated in the spline
fit. Repeated clicks on identifiable trace segments within the spline section constrains the spline fit.
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Figure 11: The maiseisDigpanel showing an example of a portion of a trace image at the begin-
ing of Line 42 (up to about the 0.95 inch trace location) that was spline-fitted. Red circles connected
by thin red lines identify locations of spline control points. Compare with the unmodified projected
trace determined by the digitizing algorithm (Fig. 1, begining of Line 42).

Note that individual control points cannot be deleted within spline sections. If the splined section
is unsatisfactory, usErase Traceo delete the projected trace in the splined section, followed by
Select Ptand striking the keyboard Delete key (see Sedlidito delete all control points within

a splined section. Figure 11 shows a splined section at the begining of Line 42, up to about the
0.95in trace location. The blank space between the (green) Edge Line and the begining of the trace
results from fading of the seismogram traces at this edge, with the Edge Line set to conserve the
Total Time in the seismogram.

6.2 Trace Concatenation

Digitizing consecutive traces in a seismogram image requires concatenating the trace at one end
of the image to the next trace at the opposite end. Storage problems over time have resulted in
degraded image quality at the edges of some seismograms (see Figures 1 and 11). Minute marks
and faded trace ends can result in gaps at trace connections that need to be accounted for. When
digitizing full seismograms, the user sets the “Edge Line” location for the end of the image that

is best defined. The other Edge Line can be iteratively adjusted to minimize the time difference
between the digitized and entered Total (elapsed) Times, determined from the Start and End Times
entered by the user in th&xport (Preview)vindow.
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The concatinated digitized traces can be examined by clicking oBxpert (Preview)utton in

the File menu, with the connection locations identified for inspection (see Fig 5). Any needed
modification at trace connections (or Edge Line adjustment) can then be performedSaishe

Dig window (near the connection locations of the indicated line number irEgport window)

and then re-Exporting. Data gaps less than 50 pixels (about 5 s) that commonly occur between
concatenated traces (and at minute marks) are automatically splined across, with larger gaps des-
ignated as missing data.

7 Digitizing Procedure

7.1 Seismograms

e Import the image, rotate and mirror the image as needed so that Time (the independent variable)
increases from left-to-right and top-to-bottom. Filter the image noise. Because filtering the image
is CPU and memory intensive in Matlab (i.e. slow), B&ve Imageption should be used so that
image filtering and rotation do not have to be repeated (be careful not to overwrite the original
image unless desired). If more than one image having the same characteristics is being digitized,
prep.images.ntan be used external &eisDig

e Set control points at both end points of all lines (or the line segment) to be digitized. It is more
efficient to set all the control points on one side of the seismogram image, and then the other side.
When setting trace-end control points for successive lines, “activatind’intee?check box makes

it is unnecessary to change the line number inLtine #dialog box.

The following two operations are necessary only when digitizing multiple traces, although this
procedure may be useful in estimating the arrival time of an earthquake signal if arrival time deter-
mination by inspection proves problematic or backgound noise estimates are needed.

e Go to the file menu and click o8ave Dataresulting in the control points “prep-*.data” file-
name being added to tHereprocess File List Click on Digitize Selectedpre-processing takes
30-45 min/seismogram, depending on machine architecture).

e After digitizing is completed, load the control points and projected digitized trace data using
Load Datain theFile menu. Loading the “tr-*.data” file will automatically load the image and the
projected traces in which the control points were selected.

The following are necessary for all digitized data.

e Compare the projected digitized traces with the underlying image and interactively correct poorly
tracked trace segments (see Sectidi).

e Enter the DPI. If the DPI is unknown, enter the physical length of the horizontal dimension of
the scanned paper seismogram in “inches” in &rap, Length dialog box.

e A least squares fit is used to determine the reference line for each trace. The linearity of each
trace and the reference line third order polynomial fit can be clearly observed by changing the
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horizontal:vertical image scaling ratio to 1:50. Change the order of fit if desired lBdhélenu

e Set the Edge Lines at both ends of the image. Setting the Edge Lines is necessary only when
concatenating multiple traces, determining the total elapsed time in the seismogram, or when de-
termining the Scale Factors (either the TSF or check the DPI). If timing mark gaps are absent,
use the TSF determined from the entered Start and End Times iBxihart (Preview)window

or use the default pixels/min value (470, or an estimate from the closest chronologically available
seismogram) in thelime (min), pixels/unitdialog box.

e ExportandPreviewto ensure digitization (and concatenation) of the traces was done properly.
Save Datan case further adjustments are necessary at a later time. Adjust connection segments if
needed by modifying the digitized data at the trace ends and recheck.

e Enter the required header information in tBeportwindow, Start Time (and End Time for full
seismograms), and the sampling rate. Adjust Edge Lines if needefixitet

¢ Save the digitized data in either or both SAC2000 Matlab file and standard SAC formats.

7.2 Generic Series: Time or Otherwise

Digitized data may be obtained for other images where the independent variable is increasing
monotonically. Determination of the independent and dependent variable scale factors is made by
entering the range of the independent variable and the physical dimension of the scanned hard copy
in the Lengthdialog boxes, respectively. The remainder of the digitizing procedure follows that
for seismograms.
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8 Keyboard Shortcuts

Sometimes it can be more efficient using the keyboard to employ trace editing and digitizing func-
tions instead of the mouse.

Notes:

1. All lower and upper case letters will have the same function unless some other functionality is
explicitly stated.

2. Keypress functions only work when the figure is the active object. The keyboard will be ignored
if any text fields, buttons, or sliders are selected. The exception is when<sirlg with a key.

[0-999] <enter> : Jump to line number (Ex: k6enter> goes to line 16)
x/ X : decrease / increase x-axis ratio
y/Y : decrease / increase y-axis ratio
<space- : Digitize Pt2Pt

> : Increment line number

< : Decrement line number

M : Reset line number to top
+:Zoomin

- Zoom out

| : Toggle Insert Ctrl Pt

D : Toggle Delete Ctrl Pt

L : Toggle Select Pts

E : Toggle Erase Trace

H : Toggle Shift Image

Z : Toggle Zoom Button

u,<ctrl> u : Undo

“” . Toggle “Centef checkbox

? : Toggle ‘Current / All Line$ checkbox
<Del> : Delete selected control points
Keyboard “arrows™1, |, «, — : Scroll image in main panel
‘. Enable keyboard prompt debugging
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9 SeisDIgSAC2000 Structures

The SeisDigMatlab header structs do not include all those found in the Lawrence Livermore Na-
tional Laboratory (LLNL) SAC2000 release. When in SAC2000, more header information can be
obtained with “SAC> help mat”. A brief comparison of structs in SAC2000 é3eisDigis given
below.

Identical to the SACdata structures in SAC2000:

struct times:
deltabeoaf
t0t1lt2t3t4t516t7t8 19
ko ka ktO kt1 kt2 kt3 kt4 kt5 kt6 kt7 kt8 kt9 kf

struct station:
stla stlo stel stdp
cmpaz cmpinc
kstnm kempnm knetwk

struct event:
evla evlo evel evdp
nzjday nzyear nzhour nzmin nzsec nzmsec
kevnm mag imagtyp imagsrc

trcLen (integer type in SAC2000)

Structs Not included in SAC files exported fromSeisDig

user, descrip, evsta, lInl, response

New struct in SeisDigexport files:

struct SeisDig:
num.pixels : total number of pixels traced
pXx_perminute
samplesper.sec
px_per.delta
original.px_perminute : value listed in SCALE FACTORS box in m&seisDigwindow
samplingmethod: always “narspline”
drum.period : value listed in SCALE FACTORS box in tieisDigwindow (minutes)
physicallength : value listed in SCALE FACTORS box in t&eisDigwindow (inches)
dpi : dots per inch
dpmm : dots per mm
imagefilename : filename of image file digitized



